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1. Introduction 
 

TAVL application is software used to connect to the server and retrieve and display 
information that FM4 stores there. 

TAVL user manual provides information needed to fully understand and operate TAVL 
application. Here you will find application installation guide, interface, reports, configuration and event 
description, operation list. Note, that some operations or functions can be enabled or disabled and 
may not be available in application. 

 

2. Getting started 
 

2.1 PC requirements 
 
TAVL application runs on a PC with MS Windows XP or MS Windows Vista with latest 

service packs. MS .NET Framework v2.0 and Crystal Reports are also necessary components. 
TAVL application supports MS MapPoint (copyright © 2008 Microsoft) or any MapX 

(copyright © 2008 MapInfo Corporation) maps (additional maps have to be installed on users PC). 
 

2.2 .NET Framework installation  
 

Download .NET Framework 2.0 from Microsoft website and install it (url: 
http://www.microsoft.com/downloads/thankyou.aspx?familyId=0856EACB-4362-4B0D-8EDD-
AAB15C5E04F5&displayLang=en). If the download doesn't start automatically, click on the "Start 
Download" button. 

 

2.3 Crystal Reports installation 
 
Download and install Crystal Reports for .NET Framework (url: 

http://213.226.139.30/Downloads/tavl/Tavl%5FClient/Crystal%20Reports%20Runtime/CRRedist2
005_x86.zip ). 

 

2.4 TAVL application installation 
 
Downloads and extract latest available version of TAVL application (url: 

http://213.226.139.30/Downloads/tavl/Tavl%5FClient/ ).  
 

2.5 Launching TAVL application 
 
Launch tavl.exe. Enter your login name and password. Additional settings can be found after 

clicking  button: client name, destination server and language. 
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3. Interface 
 

 
 

TAVL application consists of three basic parts:  
1. Toolbar; 
2. Object window (may contain track or event window); 
3. Map window. 

 

3.1 Objects 
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Object window contains a list of all available objects that are available for the client. Red color 
indicates idle state, green – moving. Date column shows timestamp for the latest coordinate received 
from device along with other additional properties (if any). After clicking 'Objects' in toolbar, TAVL 
displays them on a map. Left-click on the object in the list centers view on that object. Right-click on 
the object displays the following menu: 

• Info – displays object information entered in database 
• Hide – hides current object from visible list ('Objects' or 'Refresh' 

has to be clicked to take effect) 
• Unhide All – reveals all hidden objects 
• Edit Columns – ability to set up available columns – order, size, 

etc. 
• Configuration – opens object configuration menu (see below) 
• GeoFence -  opens FM GeoFence menu 
• Edit Object – ability to modify object number and comments 
• Send Command – displays available SMS commands for FM 

'Refresh' button displays the latest information available on server. Option 'Refresh Every' 
allows you to enter time interval in minutes for automatic refresh function. 'Always Online' refreshes 
data every 15 seconds. 
 

3.2 Track 
 
'Track' button in toolbar displays additional track 

window in object list. Choose an object, set time interval and 
click 'Find' to see the track of the object for that period. All 
additional properties are displayed as well for every timestamp. 
'Skip Min Distance' is used to discard records that are too close 
to each other – you can enter minimum distance between 
coordinates to be displayed. Left-click on the list centers the 
map on that record. Right-click allows to modify columns and 
to switch to 'Replay' mode. If two coordinates are selected while 
holding 'Ctrl' key, application calculates distance between them 
and (if available) fuel consumption for that period. 

Replay mode displays each coordinate for defined time 
interval in 'Pause' field creating a live review the track. 'Play', 
'Pause' and 'Stop' buttons are used to start, hold and stop 
preview, while 'Reverse' button replays track from the end to 
beginning. 

'Reports' button is explained in 'Graphic Reports' 
chapter (see below). 
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3.3 Graphic Reports 
 

 
 

After clicking 'Track' button and generating a track of the object a 
'Reports' button appears. This opens a new window with all properties changes in 
time scale graphics – speed, power voltage, CAN bus information, etc. 
Information provided here is same as displayed in 'Track' window, except that it 
is in graphic mode. Left-click on a record in 'Track' window shows a vertical line 
on a graph at specified timestamp. 

Some functions to manipulate the view of graphics are available. Middle 
button of a mouse increases or decreases the scale of timeline, right-click displays 
a view settings menu. Image can be copied to clipboard, saved as picture format 
or sent to printer. It is also possible to choose point symbols and size for them as 
well as line filling options. 'Set Scale To Default' is used to set back to default view. 
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3.4 SMS operations 
 

SMS operations have several buttons dedicated: 'SMS mailbox', 'Send Message', 'Send 
Command' and 'Drivers'.  
 

 
 

'Drivers' allows a user to create virtual SMS receivers. These receivers are used in following 
cases: 

1. To enter a vehicle driver name and GSM number for a possibility to send SMS from TAVL 
application; 

2. To enter a device number and GSM number for a possibility to send FM commands to the 
unit; 

3. To enter object number or driver name and iButton ID for identification. 
'Send Command' allows a user to send predefined commands to FM unit. Commands are 

entered on database using Management interface (see TAVL Management User Manual). Choose an 
object, choose a command from a list and click 'Send' to send a command. 

'Send Message' allows a user to send any text message to receiver defined in 'Drivers' menu. 
These can include configuration messages for FM unit, simple text messages for drivers, or any other 
SMS message. 

'SMS Mailbox' provides a simple SMS monitoring tool for sent and received messages. Some 
configuration messages request certain information from FM units which is usually sent by SMS. This 
information can be seen in SMS mailbox window along with delivery reports (if activated). A time 
interval for sent and received messages can be set. 'Refresh'  option allows periodic update of SMS 
mailbox window, 'All Clients' allow to see all messages from all available clients on the server. 
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3.5 Other operations 
 

'Map' button allows turning on or off available maps on TAVL application. 
After clicking 'KML' button, TAVL application launches Google Earth (copyright © 2008 

Google) application and exports current view of map – all objects or track of selected object. Note that 
Google Earth has to be installed on a PC for this option to be available. Same can be done by clicking 
'File -> Export -> To KML File'. 

'Stop' button cancels current job – object or track loading. 
'Users' allows creating a new TAVL application login for active client. Enter new username and 

password and choose available functions. Currently logged in user is able to change the settings of 
account using 'Edit' -> 'Login' menu. 

'Events' displays a new window with preconfigured events. They can be received for a defined 
period of time from selected or all objects available for the client. Event configuration is explained in 
configuration chapter (see below).  

All data (object list with subscribed properties or track information) can be exported to .CSV 
file. Click 'File -> Export -> To CSV File' and choose a folder to save it. 
 

3.6 Advanced filtering 
 
TAVL application has ability to set certain categories for every client. These categories can have 

different sub-categories that can be attached for every object. If this functionality is enabled, TAVL 
application has additional filter settings in toolbar. Vehicle identification to certain category or sub-
category is done using TAVL application. 
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4. Operations 
 

4.1 GeoFence 
 

When coordinates are sent to the server, they are proceeded using application’s algorithms. If 
coordinate is in the specified area, a notification is sent.  

In the toolbar click 'Tools' – >'Geofencing'.  
 

 
 
 

 
'Zones' menu allows you to create new, edit or view existing zones, which can be in shape of 

quadrangle, circle or polygon. To create new area, click . Enter name, attach to the zone group 
(optional) and specify coordinates by entering them in the fields or click  and choose the area on 
the map window. For quadrangle two corner points are required, for circle - center and radius. If you 
choose the polygon, double click while selecting last point and application will automatically connect 
first and last points specified. 
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When you click 'Zone Groups' you will be able to attach zones to groups. This makes object 

management more easy, because you can specify groups as destination addresses, not allowed places, 
checkpoints and set different messages to be sent for each group. 

 

 
 
When you are setting Geofencing rules, you can choose which objects to monitor and specify 

included zones or zone groups. Click 'Warnings' and choose recipients and message sending policies. 
These two are specified in Warnings menu (click 'Tools' -> 'Warnings' -> 'Warning Recipients'). Also 
set parameter in 'Transition' field for message sending when objects enters or leaves (or both) area, 
specify oldest possible warning message in 'Reject State' field and set if messages require user 
confirmation in 'Confirmation' field. 
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If you want to view messages in TAVL application, click 'View' –> 'Warning Console'. In the 

new window  Geofence warning along with other generated waning can be viewed. Settings, how 
information should be displayed are made in 'Settings' window – click  to open it. You can define 
which messages should be displayed, time interval to check for new messages and how should they be 
displayed (more detailed explanation in chapter below). 
 

4.2 Events and Warning Console 
 

Events are displayed in separate window, when FM configuration has certain events defined 
(see Configuration chapter below). If current value of any property exceeds or drops below the defined 
range, an event is generated.  

Warning console is able to display these events if it is enabled. Enter time interval to check for 
new events, and define what should happen when new event is received. Different type of warnings 
can be chosen to view. 
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4.3 Filtering 
 

Loading lots of objects takes more time and sometimes it can be very confusing. Filtering lets 
you choose which object you want to view, and hides the rest. When refreshing objects, data is sent 
only about those that are marked, so it takes less time. In the TAVL toolbar click on 'View' and 'Filter' 
or hit Ctrl + F. In the new window click on object you want to be displayed and click 'Ok'. 

 

4.4 Options 
 
'Options' allows you to customize TAVL applications 

settings. In the 'View' menu choose 'Options' or hit F9.  
Stop Speed - speed value at which the object is 

treated as not moving. This is used when coordinates error 
occurs and object is displayed on new location, it should not 
be indicated as changing its stopping point. 

Events menu – sets a sound used with warnings, sets 
if passive data is displayed in new window when its state 
changes or with all data in the objects window. Interval sets 
the period in seconds when the data is to be refreshed. 

GeoFence menu - settings let you specify line colors 
and width. 

Graphic Parameters menu - these settings define 
same graphic reports parameters as right-clicking on them 
(see Graphic reports above) - fonts and their sizes, symbol 
types and sizes, etc. 'Work Time Graphic Min Time' and 
'Work Time Graphic Min Speed' define minimum time and 
speed values at which object’s engine is being treated as 
working. 

'Use iButton' – enables iButton column in object and 
track windows. 

'Map' menu defines visual parameters in the TAVL 
map window. 'Exclude Engine Off Points' sets object to not 
moving when engine is turned off. With this parameter 'Min 
Distance In Track When Engine Is Off' is set in kilometers 
to indicate how far object can move and still not be treated 
as moving. 'Min Distance In Track' sets minimum distance 
from one point to another in the map. 'Min Satellites In 
Track' specifies how many satellites module should be using 
when setting its position. Note that minimum four satellites 
are used, but more - means better accuracy. 

'Messages Refresh Rate' - rate at which data is 
refreshed in mailbox. 

'Objects' menu - shows last known good 
coordination when no GPS satellites are in view. 

'Remember Windows Layout' - saves windows layout 
in TAVL on exit. 

It is also possible to set different symbols to 
represent the object while ignition is on or fuel counters are 
used. 
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4.5 MapInfo MapX maps integration 
 
In addition to the standard software packet, MapInfo MapX (copyright © 2008 MapInfo 

Corporation) should be installed.  
TAVL application supports files with .GST extension. These can be compiled using MapInfo 

MapX packet. 
When TAVL is launched, click on MapX icon in the lower left corner near the map window or 

click on 'Maps' – 'MapX' button on a toolbar. 
 

 
 
Click 'Open' and browse to the folder with new geoset (file with .gst extension) 
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Your new custom maps are ready to use. 
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5. Statistic reports 
 
TAVL application has ability to generate statistic reports based on GPS data and/or external 

sensors or properties. These reports can be launched by clicking 'Reports' and choosing one of 
available.  
 

5.1 Driven Distance 
 

 
 

Driven Distance reports contain information about total track for define time interval. If fuel 
measurement is present for the vehicle, this data is used to calculate total fuel used and fuel rate for 
100 km. Click settings to define distance calculation – distance can be calculated using CAN or GPS 
data, fuel source – CAN or fuel counters information and maximum fuel rate limit, which is displayed 
highlighted if exceeded.  
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5.2 Moto Hours 
 

 
 

Moto Hours report calculates total time spent while driving a vehicle. Work time is calculatd 
when vehicle is moving at greater speed than the one defined in 'Min Speed' field. Additional settings 
can be made to define fuel source and timeout in case FM is configured not to send data frequently. 

As alternative, Work Time Detailed reports provide same information more detailed. 
 

5.3 Trip Stops 
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Trip Stops report is used to monitor when, where and for how long vehicle was idle. Settings 
include: 

• 'Detect stops based on' – identifies when vehicle is considered as idle. Stops can be based on 
ignition (they have to be configured as 'Engine' data source) and/or speed. 

• 'Location Info' – reports have ability to show the place where vehicle was idle – either 
locations from server database and/or location titles used in GeoFence settings. 

• 'Location Info Source' – selects between available databases on server. 
• 'State shift timeout' – these two fields define time intervals to check for ignition or speed 

changes. If value has not changed for the period of time, vehicle is considered as idle. 
• 'Minimum Stop Speed' – a speed value which identifies vehicle as idle, if it not exceeded. 

 

 
 

6. Configuration 
 

6.1 Module Configuration 
 

TAVL application has an interface for remote FM configuration via GPRS. Note, that current 
SMS username and password for FM device must mach those entered in database, else all 
configuration attempts will result in failure. Remote configuration can also be done by sending simple 
text SMS to the module with special commands (see FM4 user manual for more details). In the object 
list right-click on the object and choose 'Configuration'. 

Configuration interface has a list of available configurations for module. These can be: 
• 'Active' – currently available configuration. Note, that when new object is added, server does 

not receive configuration from FM device and all fields are left blank. 'Active' configuration 
will show currently used values only when FM device is configured with TAVL application. 

• 'Template' – this is a template configuration. 'Template' settings are not stored in FM device, 
but on server. A selected configuration can be saved as template for one or more modules. 

• 'New' – new configuration is displayed when new settings are about to be sent to the device. 
• 'Synchronizing' – a configuration that is queued for update. When saving new settings 

(configuration), new configuration is renamed to 'Synchronizing' until process is successful or 
time-out expires. If configuration is successful, then 'Synchronizing' is renamed to 'Active' and 
new date can be seen indicating when it was became available. If configuration is not 
successful, 'Synchronizing' is renamed to 'Failure'. 

• 'Failure' – last unsuccessful configuration. 
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Another window has 'Event Configuration', 'Module Configuration' and 'Global Parameters'. 
'Module Configuration' and 'Global Parameters' have same interface as FM4/FM2 configurator and is 
described in FM4/FM2 User Manual. Note, that TAVL application interface only allows configuring 
those IO elements that are enabled in database.  

'Send Method' field identifies how configuration should be sent to FM4/FM2 – by GPRS, 
binary SMS or both. 'Save Full' button saves selected configuration as 'New' and renames it to 
'Synchronizing' when server tries to contact module. 'Save Changes' only saves new changes since last 
active configuration, but have in mind, that first configuration for module always has to be saved using 
'Save Full' option. 'Update From Server' refreshes available configurations list. It does not read current 
configuration from module, only refreshes status of all available configurations. 'Save as Template' 
saves currently selected configuration as template for one or more objects. 
 

6.2 Event configuration 
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'Event Configuration' menu allows configuring events for IO elements. In the picture a sample 
is shown how to configure over-speeding event that will send SMS to defined recipient. 

Choose an IO element from available in 'Available Events' window (more can be added by 
enabling IO elements in database) and click 'Add'. Enter minimum and maximum values in the fields 
'Min' and 'Max'. When current value of IO elements drops below or raises above defined range, a 
message will be sent to the recipient entered in 'Event Address' field 
 

7. Localization 
 

TAVL language localization tool is used to build localized (translated) version of TAVL 
application.  

 

7.1 System Requirements  
 

Download and install .NET Framework SDK v2.0 from: 
http://www.microsoft.com/downloads/thankyou.aspx?familyId=FE6F2099-B7B4-4F47-

A244-C96D69C35DEC&displayLang=en
Download Zeta Resource Editor from:  
http://213.226.139.30/Downloads/tavl/Tavl%5FClient/Local/ZetaResourceEditorEx.zip
Download localization resources from:  
http://213.226.139.30/Downloads/tavl/Tavl%5FClient/Local/Localization.zip
 

7.2 Modifying Files 
 
Extract Localization.zip and launch WinRes.exe from 'Start' – 'Programs' – 'Microsoft .NET 

Framework SDK v2.0' – 'Tools' – 'Windows Resource Localization Editor'. Open and modify the .resx 
files in your folder. If text is too long, nearby fields can be adjusted or moved so it would fit. 
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Modified files must be saved in form <Original Filename>.<Culture Name>.resx in the same 

folder (i.e. FrmLogin.resx → FrmLogin.lt.resx) simply by clicking 'Save As…' and choosing your 
language. Do not change original file name. 

Some files do not contain material that is displayable in the tables and can not be edited with 

Windows Resource Localization Editor. An error "Error - InvalidDialogMissingName Valid dialog or user control 

resource files must be generated by the Visual Studio Form Designer and the Localizable property of the Form must be set to 

'true'."is displayed in the window. In such cases, these files have to be edited with Zeta Resource Editor. 

Open the table – on the right column a list of names available in TAVL application is displayed. 

 
 Rename only text in this column and leave brackets and number as they are – changing 
these values might cause errors in application. Rename necessary fields and save the changes. Later 
rename the file so it has correct extension (i.e. lt.resx). 

 

7.3 Compiling TAVL Application 
 

After changes were made, TAVL application must be compiled. Run cmd.exe ("Start" - "Run" 
write “cmd” in the field, press “OK”) and go to your localization folder (C:\Documents and 
Settings\<your user>\Desktop\Localization).  

To move between directories in cmd use command “cd”: 
• cd <exact destination> - to move to directory you want. 
• cd.. – move one directory back 
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Next element to type is exact path to your “msbuild.exe” file 
(C:\WINDOWS\Microsoft.NET\Framework\v2.0.50727\msbuild).  

After this you can build solution (builds all projects) or single project. 
• To build solution type: 

tavl.sln /property:Culture=<culture-name> 
e.g.: msbuild tavl.sln /property:Culture=lt 

• To build single project type: 
<projectName.csproj> /property:Culture=<culture-name> 

Final command line should look like this: 
 

 
 
Note: if you get any errors about missing files during compilation process, launch WinRes.exe 

again and create missing files. 
Copy new satellite assembly files (*.resources.dll) from bin folder to TAVL application folder. 

Copy entire folder with name corresponding to your language (in this case – folder “lt”) from the 
directory C:\Documents and settings\<your user>\Desktop\ Localization\tavl\bin\Debug and paste 
it to TAVL application folder. 

Next time when you run the TAVL application, you will be able to set new language. 
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8. Frequently asked questions (FAQ) 
 

1. Why doesn't objects trail match roads that are shown in the map? What is the accuracy of 
GPS? 

 
Object trail doesn’t coincide 

with roads shown in the maps because 
of GPS limited accuracy. GPS 
accuracy depends on location 
(geographic latitude, longitude), 
satellites’ location and ionosphere’s 
conditions. In perfect conditions 
(sunny weather, no clouds, in open 
area, without skyscrapers, woods) 
accuracy can be about 3 – 5 meters. 

Usually accuracy is estimated 
using statistical method CEP (Circle of 
Equal Probability). This method 
allows us to consider, that in 
probability of 50%, object’s coordinates’ error does not exceed designated values. 

  

Distance, meters

Otherwise, roads in the map not always are defined very precisely (especially considering 
Eastern Europe). Another possibility is that new roads don’t exist in the map. 

 
2. Why do data transfers from server to application take so long? 
 
Duration of data transfers from server to user application depends on amount of data and 

speed of Internet connectivity. While object registers many parameters very often grows data quantity. 
Then transfer time for long requested period of time could be very long. So if you want to increase 
data transfer time you should decrease requested data time period. 

One more way to decrease data transfer time is to decrease frequency of object’s parameters 
data (time T1 should be not 1 minute but 2 – 3 minutes). 

3. Why it is impossible to request current object position? 
 
In most cases you are unable to receive information about current object’s location, because it 

is out of GSM coverage (is in the sea, in deep woods, etc.) 
 
4. It's one or two hours since module sent its data. Why is it not refreshed? 
 
Module is sending data to the server at fixed time. If the connection is not possible (there is no 

GPRS context), the next sending will be at fixed time. Still You can send the request, and get the latest 
data. Also profile may define data acquirement less often (i.e. every 10 minutes when object is not 
moving) and setting allow only full packet sending. 

 
5. Why only yesterdays data is shown? 
 
Either module didn't sent data because it's not time to do it or it couldn't send it because of 

network problems. Solution is to configure module so it sends data at desired time. 
 
6. How can I know objects location if it is not sending data by GPRS? 
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You can send a request and get the SMS with 24 coordinates (see chapter 4.4.4). 
 
7. Why is object changing its coordinates even when engine is off? 
 
It is because of GPS accuracy. If object is standing between tall buildings or in from of the wall, 

module doesn't see enough satellites to set its exact coordinates. Then each coordinate is calculated 
with a slight error. Error depends on number of visible satellites. If object is standing between tall 
buildings or in front of a wall it may not be enough for module to set its position correctly. 
 

8. I'm receiving incorrect time – it's always same interval ahead or behind current time. 
 
This is happening because of incorrect timezone settings on PC. Please choose matching 

timezone in windows regional settings. 
 

9. Changes Logsheet 
 

Nr. Date 
New 

version 
number 

Comments 

1 080625 3.1 Localization description revised 
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